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Last Time: Tonight:
» Additional Top-Down Design  Finish Top-Down Design
* Renderings

* Form Project Groups




AutoCAD Next Up?

* We’'re going to tackle an introduction to AutoCAD in the next few lectures
» Please go to Autodesk’s educational community site and register

o www.Autodesk.com/edcommunity

» Once registered you'll be able to download AutoCAD 2012

* Please do so in anticipation of the lectures to come




EXERCISE - Top-Down Design Tools

& CAP (Active) - Pro/ENGINEER Education Edition FEX

« Extrude a solid feature from the

DZE&QG nerBREER - BrFRAQACEER 8000 gliakT »
BASE_PLN to the bottom of the part

&3

08, CUPve, axis of poink ko spedfy depth of side 1,

is or point o specify depth of side 1,

HEEE

Shaw ~ J[ Settings ¥ ]
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« Sketch on the BASE_PLN cerr
- LT Top 2 ~
L7 FRONT 3
. . azz&ﬁ:ﬁzm id 3:9 g
« The USE EDGE tool will give | ..
. e
. . ZiCopy 2
the inside curve g |
%zztj‘r:fclow Geom id 327 15
o Extruds 2 16

& Insert Here

« OFFSET EDGE (.060) for

outside edge of feature

» Select ‘Extrude to Selected...’

and select the CAP_PLANE
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EXERCISE - Top-Down Design Tools

» Basically repeat steps down
for CAP

« Copy BASE_PLN

e Extrude solid feature

from it
e This time:
 Cut from the solid

» Offset .065

& HOUSING (Active) - Pr

o/ENGINEER Education Edition CEX

Help
Wl - Br®aa@s sk 8000 |al e hie

1

Placement  Optians

AEEE]

Ola e-C——I% g & = n B ] X

Properties

(3

Show ~ J[ Settings ~ ]

. Feak #

(1 HOUSING PRT
7 RIGHT 1
L LFTOR
/7 FRONT

3
é-%r—w_csvs_[ 4
by ExternCopy| S
Copy| 6

7
3

i Copy L
| {7 Offset 1 9
S [ZyCopy2 1
7 Extrude 1 11
ol Extrudez | 12
C ot dMerge 1 13
D Merge 2 14
- tmerge 3 15
- Solidfy 1 16
| B ExternCopy| 17
o Insert Hers
2 7 #Extrude 3 |<Nanes
ﬂ 52000 | <Mone >
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EXERCISE — Top-Down Design Tools

» Extrude a partition between
where the coffee will be
ground and where the

electronics will live

 \Web thickness is
.100in

@ HOUSING (Active) - Pro/ENGINEER Education Edition

Ele Edt W¥ew Insert Analysis Info  Applicstions Tools Window Help

DB EH&Q L v b B w

- Ergaa@s el 8600 [dhekSir

&WARNING: layer display status was not saved.
* HOUSING has heen sa
Sy Select planat surface

A=

n saved,

or datumn plane.

Show = || Seltings ~ |

(7] HOUSING PRT

£7 RIGHT

LF TOP

7 FRONT

é PRT_CSYS_L
Extern Copy

bl Exeern Copy
@ Copy 1
(2 Offset 1
~fcopy 2
&) Extrude 1
) Extrude 2
@ Merge 1
F Q Merge 2
AMerge 3
- salidify 1
1% Extern Copy
&) Extrude 3
o) Extrude 4
- & Insert Here

Feal #
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EXERCISE — Top-Down Design Tools

\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\ dow  Help

 Back to the assembly, DEH&G: o~ sREEEN - DS hacsoR 80602 Llk%T e

i ! is was not saved, &l |
insert the WHEEL
component

« How much coffee can we

fit in the space allotted for

grinding?
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EXERCISE — Top-Down Design Tools

Create a new model to measure the coffee volume

@ COFF_VOL (Active) - Pro/ENGINEER Education Edition

[ ) File > NeW > Coﬁ_vol . prt Fle Edt Wiew Insert Analysis Info  Applications Tools ‘window Help

DEZEH&GL ve i BREER . ErFra@4FshE[seo0i(giakTiv

e Define surface sets
£ Select datum references
& COFF_YOL has been saved

» Copy outer surface from [D | e =
BHREE :

Show ~ |[_Settings ~ |

model oo

L7 RIGHT
LT TOR
| L7 FRONT

- Z<PRT_C5YS_DEF
g Extern Copy Geom id 39

« Copy BASE_PLN from e s

2~ O
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skeleton

DAL SR ow D ¥

Lt
=

| Er—

BCB — Mar. 22, 2012 EN1740, S2012



EXERCISE — Top-Down Design Tools

Create a new model to measure the coffee volume

* Solidify
» Add R.250 round to top

* Trim solid at BASE_PLN

@ COFF_VOL (Active) - Pro/ENGINEER Education Edition
Elle Edit ¥iew Insert Analysis Info Applications Tools ‘Window Help

D2EaQR vorhEhiEn - BrgaalsdtesR (oo izisnG v

e Select quilts to merge,

® COFF_WOL has been saved,

HEEE]

gy Select a sketeh, (IF an internal sketch is preferved, the "Edit” option can be Found in the Placement panel.)

& Select a quilt or surface, to add or remove material from a solid,

Shgw J[ Settings

(7] COFF_WOL.PRT
7 RIGHT
L L7 TOR
47 FRONT
%PRT}SVSDEF
- by Extern Copy Geom id 39

- B Extern Copy Geom id 51
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EXERCISE — Top-Down Design Tools

Create a new model to measure the coffee volume

IE GRINDER (Active) - Pro/ENGINEER Education Edition

File Edit Wiew Insert Analysis Info Applications Tools Manikin  Window Help

» Assemble coffee DEHAGG I i BbREEER - Dr¥0aa0soR 0000 alis%Tie

g Select any reference for auto type constraining.
£ Select offset sligning surface o datum plane on ot_her part.

volume part into top level =
St~ J[_sotngs -

assembly

= [T GRINDER_SKEL PRT
7 DML

£70TM2
/7 DTM3
= S0

7% sketch 1
S .:‘ Cap

7 MeTOR
o/ BATTL

£ BaTIZ
-7 THP_PLAKE

£7 BATT_COVER
{7 BASE_PLN

% Insert Here:
£ BSW_RIGHT

£7 ASM_TOP
Sl _FRONT
% ASM_DEF_CSYS
-] CAPPRT
- (] HOUSING PRT
-] WHEEL PRT
-] COFF_YOL.PRT
= Insert Here

DRPSmIs oL
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E S 2

Clipping Staie:A
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EXERCISE - Top-Down Design Tools

Use Component Operations to determine volume

» Edit > Component

Operations

e Cut Out

» Select volume model > OK

» Select cap part > OK

Component Cperations

\U@ratinns

« Done 2

-

! = Select

1 Me

Stp Feature Cperaftions
* Done/Return Restructure
Select 3
* Repeat with Housing and iy Eind... Chri+F
Hyperlink ChelHE
Wheel et o

nu Manager

Copy
Insert Mode

Reorder

Group
—uk 2k

Transform

Done,;/Return




EXERCISE — Top-Down Design Tools % Mass Properties

Use Component Operations to determine volume

* Go back to volume model

» Analysis > Model > Mass

Properties

* Click the goggles

Analysis | Feature |

| Select items

Usge Default

HBEE]

Show = [ Sallings = |

[} COFF_YOL.PRT

| L7 RIGHT

L AT TOR

L7 FRONT

| §PRT_C5YS_DEF

L fycut outid 3s0
- Lcut outid 585
L fycut outid 758
" o Insert Here

@ COFF_VOL (Active) - Pro/ENGINEER Education Edition
File Edit Wiew Insert Analysis Info Applications Tools ‘window Help
~ B ey Y B B[Sl B g rall i = + AE
ID2EH&G G oo b BREEW -IEBF-®RAAEHGH _
Denzity
& COFF_WOL layer D6__PRT_ALL_SURFS,
® Layer statuses changed successfully, Repaink to see the resulks,
ANWARNING: layer display stabus was not saved,
* COFF_WOL has been saved. ,-':‘-,ccur.ac_lrl
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0.00001000

MASS =

L

£
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DEWSITY = 1.0000000e+00 POUMD £ [k

1.1701E78e+01 POUMD

1.273397 101 5.0114070

TR

CEMTER OF GRAVITY with rezpect ta _C

2+

IMERTIA with respect to _COFF_%0L coo

Y

W
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| Quick
=
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%) Lv]
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Smart v | g




EXERCISE - Top-Down Design Tools

Fast forward..... built the model and customer feedback IS IN

» As a result of focus group study we have to change the model:
* Ellipse cross section isn't “ellipsey” enough
* Not enough volume of coffee in grinder
 Straight curve interface has been done, need a new look

» Back to ID model




EXERCISE — Top-Down Design Tools

« Edit ellipse on base feature
* Modify Rx to 2.25
» Modify spine feature

» Should extend 2.47
from RIGHT

« Regen

DJER_ID (Active) - P

File Edit Wiew Insert Analysis Info Applications Tools Mwindow Help

IDEHS&GQ oo § BREEEE

e R A@A P sk

P
s
"
e
wlt
z

® Showing section modification driven by new dimension values.

& Select a YERTEX/ENTITY/CENTER ta Drag or Click on the Dimensian ta Modify.,

& Select items such as Dimensions, Sections, Trajectories, Tolerances, Surface Finish or ther Features for editing
e Select items such as Dimension, Section(s) or Features for editing

>

Shgw J[ Settings

(7] GRIMDER _ID.PRT
L7 RIGHT
L7 TOP
LT FRONT
% PRT_C5Y5_DEF
- Mgy Extern Copy Geom id 39
- EE
A7 Copy 1
e Crude: 2
5 --@Merge 1
7 Round 1
i Round 2
-+ JRound 3
4 Round 4
\

i '

i - A Project 1
2% Project 2
~Trim 1

o Insert Here

[fokeedt @@
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EXERCISE - Top-Down Design Tools

* Replace straight sketch with

circular section

*16.00 dia; center 3.00
down and 1.25 to the left

& GRINDER_ID (Active) - Pro/ENGINEER Education Edition

Elle Edit Wwiew Insert Sketch Analysis Ipfo  Apgplications Tools wWindow Help

- Br®a_a@s

g5 Select a paint on the arcfdircle,

 When canstraint is displayed: Right click to disable it, Press Shift + right click ta lock it, Use Tab key to toggle active constraint,
B Select the center of a circle,

 When canstraint is displayed: Right click to disable it, Press Shift + right click ta lock it, Use Tah key bo toggle active constraint,

Call =1 =0 7
Shgw ¥ [ Setings ~

[ GRINDER _ID.PRT
L7 RIGHT
L7 TOP
L7 FRONT
i 35 PRT_CSYS_DEF
I3 Extern Copy Geom id 39
o Extrude 1
171 Copy 1
7 Extruds 2
Arerge 1
| P Round 1
i Round 2
i Round 3
4 Round 4
+ Insert Here

=

~R8
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0O x

1

RO %

X 4
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EXERCISE — Top-Down Design Tools
ID model is updated

JER_ID (Active)

Fle Edt Wiew Insert dnalysis Info  Applications Tools Viow Help
» Move on to the parts Lok BB 0,5 o TR T R

# Regeneration completed successfully.
* Feature redefined successfully.
AWARMING: laver dlép\awsta_tus was not saved,
* GRINDER_ID has been saved,
B

Show ~

(1 GRIMDER_ID.FRT
£F RIGHT
-7 TOP
- £F FRONT
% PRT_C5Y5_DEF
- Mg Extern Copy Geom id 39
& () Extrude 1 '
iZicopy L
) Extrude 2
- --(g—'_Mérge 1
=} Round 1
- Round 2
“ Round 3
-+ Round 4
o
e .
B A Praject 1
- 7o Project 2
e (U Trim 1
o Insert Here

| Er—
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EXERCISE — Top-Down Design Tools
Part update

B Failure Diagnostics

Filz Edit Wiew Unda Changss
° g h C p Click for: Ivestigate
Re enerate t e a < Overview > < Feature Info > z::ogil
FEATURE #14 (PROTRUSION), PART CAP, failed regeneration. Done/Return

Feature aborted. Quilt must be closed for this feature.

» Failure mode -

-7 RIGHT 1
L7 TOP 3
- -7 FRONT 3
[ C I I S u reSS -%PRT_CEVE_DEF 4
5 Extern Copy Geom id 41 B
i'_ﬁ Extern Copy Geom id 39 &
i'_‘ Extern Copy Geom id 115 7
i1 Copy 1 &
(2 Offset 1 9
£ Extrude 1 10
@ Copy 2 11
g (5‘ Merge 1 12
IMerge 2 13
# Insert Herel
T BSolidify 1 14
i’_‘ Extern Copy Geom id 327| 15
1) Extrude 2 16
<
Fix Medel: CAP
£ I | )

3 selected Smart - | g
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EXERCISE - Top-Down Design Tools
Part update

& CAP (Active) - Pro/ENGINEER Education Edition

File Edit Wiew Insert Analysis Info Applications Tools ‘window Help

* Gointo ID model and copy ~ |fosen o0 Bl R EREAARS S0 0890 gt AN

g Failure has been resolved. Do you want to exit Resolve Feature mode? =
* Part 'GRINDER_SKEL' not changed since last regen.
. ® Datum planes will not be displayed, =
re d efl n ed C u rve + Shaded madel will be displaved =

% w5

Show ~ J[ Settings ~ ]

(7] cap.PRT

* Need to update some ey ;
references b ?
@ of?set 1 9
Loy n

- It's faster to go through | === |
Failure Mode than start

overl!!

e Here we are

DA Lok @

Smart v &




EXERCISE — Top-Down Design Tools
Part update

@ HOUSING (Active) - Pro/ENGINEER Education Edition

File Edt Wiew [Insert Analysis Info  Applications Tools Window Help

.Same Steps Wlth the IDEE&G Q2 oo B R EEw Brfaads Pl 0000 Qi ie

WARNING: layer display status was not saved., L]
® HOUSING has been saved.

&WARNING: layer display status was nat saved,

Housing e

Show = || Seltings ~ |

- Feat #
(7] HOUSING PRT

£7 RIGHT 1
LF TOP 2
£7 FRONT 3
3{« PRT_CSYS_[| 4
e 5
[
7
! 8
(21 Offset 1 9
~fcopy 2 1
&) Extrude 1 1
) Extrude 2 12
@ Merge 1 13
F @ Merge 2 14
AMerge 3 15

- & Insert Here

[E 3|« >
FS(MERGE_E')' ‘

Smart 18

)
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EXERCISE - Top-Down Design Tools

B Mass Properties

Assembly update Analysis | Feature |
n— L3575 | Select items |
: R TR Use Defaul
« May need toredefine | . . . . . .. -@rzoaag
_ S Density 1100000000 v
a feW thlngs here and « Part SEINDER I ot changed e FaErEsy ||:|_|:||:||:||:|-| onn V|

HBEEE

Shaw ¥ J[ Settings ~ ]

there, but the volume

[T GRIMDER. ASM

&/ [T GRINDER_SKEL.PRT

£ 7 BEM_RIGHT
L ASM_TOR

number comes back g
B pSM_DEF_C5YS

& ] cap.PRT

& [ HOUSING, PRT

(] WHEEL PRT

( ) u t [ £OFF WGLFRT:
L] & Insert Here

SURFACE AREA = 7.0054453=+01 IMCH
DEWSITY = 1.0000000e+00 POUMD £ [k
MASS = 1.6009323e+01 POUND

YOLUME = 1.6009323e+01 INCH™3 d

CEMTER OF GRAYITY with rezpect ta _C
O O£ FAT01516e-02 4.9762709e+(

IMERTIA with respect to _COFF_%0L coo

I
Fal i | 3 ﬂ

| Quick

w | | bazz Prop 1 |

v]  [x]

= faél
TM2_ASM TOP Si
TGO i
)
i
cl Staterd il
ipping Stae:
o &
&
[
¥ &




EXERCISE - Top-Down Design Tools
Summary — Where did we use Top-Down tools
» Skeletons
* Provide a layout for entire product and position of primary systems
» Shared Geometry
* Allows for single-source, product-level geometry specification
» Component Operations

» Use product components to garner other information




Rendering

Photo Quality Images of CAD models

http://www.ptc.com/product/creo/advanced-rendering- extension




EXERCISE - Rendering

Blank Surface and Curve Layers

e Click Show above
model tree and select

‘Layer Tree’

 Highlight the ‘Al
Curves’ and ‘All

Surfaces’ Layers
* RMB > Hide

* RMB > Save Status

) GRINDER (Active
File Edit {iew
H0EE
® Part ‘GRINDER I
® GRINDER layer 0
® Layer statuses cl
® GRINDER layer 0!
§o
Lo
GRINDER AS
S.

-3 01_DEFAUL
-2 02_DEFAUL]
-6 03_DEFAUL
£ 04_ALL_PLA

£2]
&g 11 ALL_GTOLS

66 14_ALL_NOTES
- fE 15_DRIVEN_DIMS

£ 17_ROUND_FEAT

CU
m!m! i Reset Status
10_ALL_DIM: i

@ 12_ALL_DRFT_GEOM
£ 13 ALL DETAIL ITEMS

{2 16_COPIED_GEOM

-« 18_COMPOMNENTS

iojs  Tools Manikin  ANSY513.0 Window Help

ooy BEREREEN OB rEnalstEBE oo o a La%

NewLayer... see the results.

Delete Layer
Rename

Layer Properties...

Cut Item
Copy Item
Paste Item

Remove [tem

Select ltems
Select Layers
Layer Info
Search...

Save Status




EXERCISE — Rendering

Render Controls

lE Render Control r“

ﬁ'{g GRINDER (Adwe) F\Brown_Stuf . | }
» One-stop shop for all o i [ e L?Efg‘ [éi % @-'3 ‘% = ﬁ ﬁ%ﬂ #% QC
ADNCS | Bepaint 1
. .‘0 Shade ) " 1
things related to | suenel® T Sr—
] | -b.use':nz Q_ﬁ_ﬂﬁaﬁm y lent Mode to terminate.
rendering Do e
—5},@”7 ;:;l itute |
- "] GRINDE Explode
d VIeW > MOdel SEtUp > :iﬁﬁ}! View Manaies
7 At Envelope Manager
Render Control 0 s
BH“E) "'M:;déigg;up
o Inse P
Display Settings

Activate the rendering toolbar
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EXERCISE - Rendering

Orientation

» Save an orientation
so the model can be
put back in the same

place for updates

» Use Dynamic

Orientation

* Remember to Save
with a name you'll

remember

-
| Render Control

) GRINDER (Active) F:\g

File Edit View Inse

C)

DEEEH
N BEJEJEJE

T4 O <@ ) Y E X

# REMDER view saved.
g Select front surface or
g5 Select front surface or

B The specified view was

wr
not found.

€Sys axis.
CSYS axis.

[T GRINDER.ASM

£ 7 ARIGHT
{7 ATOP
/7 AFRONT
LA ACSD

[#-[] CAP.PRT
iii [ HOUSING.PRT
‘. Insert Here

Show T Settings T |

([ GRINDER_SKEL.PRT

Feat #

[ Y I A P

[ Crientation

Dynamic update

w Saved Views

Standard Crientation
Default Orientation
BACK

BOTTOM

FRONT

LEFT

REAR

Mame

L 2gave

0.000
0.000
0.000

LI LML LS Ll L

[ ok | |[cancel |




EXERCISE - Rendering

Set Colors and Transparency

-

; (3 GRINDER (Active) FABron Fender Control ﬂ =
* View > Color and EXTWT Y [e— .., —— A~ |
peunal|BlH 6 O 3 L B R XS
Appearance (or from ——— -
" e A o=
t O O ar ® Regained floating license: you can resume working.
) A
[Shgw v )t v
« From the drop down, |[gsess:
select Components on |
» Select Component e =
( .Dim Intensity Eng[l'lrt lw.m
» Select Component TN -
| ||~ =000
and click Apply e
m [llne gl . ‘mm
» See Advanced tab for S
transparency P (o]

| | En—




EXERCISE - Rendering

Room Editor

& Room Editor =1

File Room

Room Appearances

-

» Set the stage — create

| Render Control

T3 GRINDER (Active) FABrown Stuffites)

ey ! = |

File Edit View Inset Analysis Ints AQPWeamon
DEDRBEEE G o«
L4 CIEJE © PIF

» RENDER view saved.

a scene for the model

* Using the Position, iz
i e ]
(Srw [ Ser v

Rotate and Display

& {0 GRINDER_SKEL.PRT
{7 ARIGHT
{7 ATOP
{7 AFRONT

tabs orient the model to |

& (] CAPPRT
(] HOUSING.PRT
# Insert Here

the space

6ok Wankn ANSYS 130 Window  Help

EiEwn cRrgmaa@estaslh e ood)a,

Ceiling 2.500
Floor 0.360
Wall 1 -1.000
Wall 2 -1.000

Wal 3 3.000
Wall 4 3.000

Scale
Smaller Scale Larger
[ Scale Foor




EXERCISE — Rendering B Py

File Room

Room Appearances

Room Editor

-

| Render Control

» Uncheck everything but —
yIng B > IBCHA) RE

[ RO (o) F:\Bmwnﬁt\d’ﬁ; = = ‘.‘ ‘.‘ ‘.‘ ‘.‘
the F|Oor and Wa” 2 T — |
NEDREFE0G G oo | BEREEm I -Er@naaQsdtalhk o ol
% BJCIBJEIE @ RIF ‘.‘

.
ust be in shaded display to Align Room.

» Apply textures and e

render

|~ Lock Roam to Maodel
| Bostion | Botate | Dspay |

[ g izgzi&sx& PRT ; Walls Displayed
--{7 ATOP 3 [
L7 AFRONT 4 | Celing Select Al
- 2x ACSD 5
i AN 6 YT
be gaﬁz;’gﬁ ot 4 [7] Floor | Unselect Al |
V & Insert Here
] wall 1
[&] wall 2
[ wall 3

Digplay Options
@ Shaded () Wirsframe

| Closs




